User guide for Cary 5000 absorption spectrometer with external DRA 1800 attachment.Do not remove

(last updated 08/15/2019)
This guide is for use of the Cary 5000 with the diffuse reflectance accessory, DRA.  For use without the DRA see User guide for Cary 5000 in absorption mode.
Important warnings!
· Never plug or unplug the external DRA attachment when the instrument is on.  
· Do not put white light into the DRA with the DRA connected to the Cary.
· Minimize the amount of time that the integrating sphere is open.  
· Wear clean gloves while using the instrument
· Do not use compressed air dusters on any mirrors or optics.
· Do not use liquid or powder samples in the integrating sphere.Start

Quick Start for using DRA
1. Reserve time on the scheduling website.
2. Fill out logbook for the Cary.
3. Turn on computer 
4. Click on the Cary Scan icon on the taskbar and wait till  you see the green traffic light.
5. Check lens and mirror are correct for your measurement. (Ware gloves to change the mirrors or lens).
a. Install Small Sample Kit mirror (M3 SSK) or regular M3 mirror if needed
b. If using SSK install correct lens L2.
6. Make sure the cover for the DRA is fully closed then turn Cary on.
7. If you get an error go to the section below on Startup Errors.  
8. Wait 20 minutes for the lamps to warm up.
9. Remember never ever put white light into the integrating sphere when the Cary is turned on. To align the instrument use 550 nm light.
10. Τhe optics need to be checked and aligned before each use to make sure that 1) the sample and reference beams are not clipped at the entrance to the integrating sphere 2) the sample beam does not overfill the sample and 3) the sample beam is centered on the sample. 
a. Put on clean gloves.
b. Under the commands menu click on Go to, and then type in 550 nm (do not use the “align” option). 
c. Darken the room lights, and with a white card at your sample position you should see a green beam.
d. Use the alignment screws on top of the big mirror M3 (Figure 1 and Figure 4) to align the beam onto the center of the sample.
e. If the beam is clipped at the entrance to the integrating sphere you need to use mirrors M3 and M1 to make the beam go through both the front slit and hit the center of your sample. Usually you first use M1 to make the light go through the front slit of the integrating sphere and then use M3 to hit you sample.  Redo do this several times until the beam does both at once.
f. Check that the reference beam is hits mirrors M4 and M5 close to the center and goes through the center of L1 and is not clipped at the entrance of the reference beam into the integrating sphere. Use mirror M5 to center it on the entrance.
g. Check that the sample beam will go through only the sample.  If the sample is small you may need to mask the sample and use a aperture to restrict the entrance to the integrating sphere (look in the drawers for the Cary for apperatures).
h. For help with alignment, talk to one of the GLAs and read the alignment instructions, which can be found under the Help menu.
11. Select Setup[bookmark: _Ref5115083]Figure 1 Photo of diffuse reflectance accessory with beam path.

a. Set the  wavelength range, %T, Abs, or %R
b. Under Options tab: set slit width, SBW, to 2 nm, and Detector and Grating change wavelengths.
c. Under Baseline tab: chose zero/baseline
d. Under Storage tab: Set your filename
12. Check that all exits of the integrating sphere are blocked with full reflectors. 
13. Check how you will mount your sample and if you need to use an aperture or masking to make sure the light will go only through your sample.  You will need to run the Baseline correction with everything in the beam path except your sample. If using an aperture for reflection or transmission measurements, please see the “Aperture kit for small samples” section on page 7.  
14. Choose Baseline and run 100% T scan, then block the sample beam at the entrance to the integrating sphere for the 0% T scan. 
15. It is good practice to run a spectrum with no sample after running Baseline to make sure that you have a good 100% T line.
16. Mount your sample
17. Choose Start to run the spectra 
18. When done remove sample and remount reflectors.
19. Turn off Cary
20. Shut down computer.



Introduction and Help
For a complete guide to the Cary hardware and open the Cary “Scan” program and click on the Help tab.
Hardware: Help > Help topics > Accessories > Cary 4000/5000/6000i > Solid Sample > external DRA 
Software Help > Help topics > Software Applications > Scan


After a Startup Error 
1. Click ok and let the Cary continue the initialization process.
2. Go to the Commands:GoTo menu option to go to 500 nm.
3. Check that the small aperture in the sample light path is all the way open.
4. Check that there is no sample on any of the ports or inside the integrating sphere.
5. Turn the room lights off.  Check that the sample green light beam comes out of the sample monochromator window and goes into the integrating spher. Check the reference beam in the same way (Figure 1). 
6. If you don’t see any light coming out of the monochromator
a.  go back and use the GoTo command again and wait until it completes before opening the instrument.
b. Check that there is nothing blocking the light from entering integrating sphere.
7. Close the sample compartment on the Cary and make sure you hear the interlock click.
8. Turn off the Cary, wait 10 s, and then turn the Cary back on.  It should now startup correctly.



Local User Guide for the Cary 500 with Diffuse Reflectance Accessory Integrating Sphere.
Turning the instrument on:[bookmark: _Ref319836202]Figure 2 Integrating sphere exit slots.

Open the Cary Scan program on the taskbar or Desktop[bookmark: _Ref319836194]Figure 3 Integrating sphere entrance slot.

The DRA must to be fully closed in order for the instrument to initialize. Turn on the instrument (0/I switch on the lower left side of the front of the instrument).  In the Scan program, watch the lower left corner to see the status of the instrument. When the traffic light is green the Cary is ready.  If there is an error message see Startup Error section above.
Configuration and alignment 
There are four positions in which the sample can be placed for use with the integrating sphere (see Figure 3 and Figure 2).
1. The entrance slot to the integrating sphere is for normal incidence diffuse transmission
2. The rear slot is for normal incidence diffuse reflection
3. The center mount holder allows for variable angle diffuse reflectance and transflectance measurements
4. In addition, the VATH (variable angle transmission holder) accessory can be put in front of the integrating sphere for variable angle specular transmission measurements. If you would like to use the VATH accessory, please talk to one of the GLAs for the instrument first.  
Large Sample Setup 
There are three positions for the large standard M3 mirror (see Figure 1 and Figure 4)that correspond to the three sample positions (Transmission, Center, and Reflection).  Each of the mirror positions will focus the light onto the position of the sample.  The three different mirror positions are marked T (transmittance slot), C (center mount), and R (rear reflectance slot) in Figure 4. Thus, the mirror needs to be moved to the right position depending on the placement of your sample.  The cable for the DRA can get in the way of moving this mirror.  Ware gloves to handle the mirrors or lens. Turn off the Cary first, if you need to unplug the DRA to move the mirror. 
Small Sample Setup with SSK
The M3 mirror is replaced by the small sample kit mirror (M3 SSK) in the T position.  Lens (L2) mounts in front of the sample (Figure 1 and 4).  There are three lenses (S2 or L2) that can be used again for the three positions marked as T, C or R. 
Each time the sample configuration is changed, the optics need to be realigned, such that the sample and reference beams are not clipped at the entrance to the integrating sphere and that the sample beam is centered on the sample. 
1. Put on clean gloves.
2. With the top door to the DRA closed, under the commands:Go to, and then type in 550 nm (do not use the “align” option). 
3. Darken the room lights, you should see a green beam, which you can use to align the beam onto the sample (Alternatively, if you have trouble seeing the beam: Block both the sample and reference beams from entering the integrating sphere. Under the commands menu choose align to switch the gratings to zero order to send white light into the DRA.  The white light must not enter the integrating sphere or it will damage it!!)  
4. Most of the mirrors have two knobs, which you can rotate to adjust the vertical and horizontal positions of the beam.  Start with mirror M1 and adjust so the beam hits the center of mirror M3 then use M3 so the beam hits the center of the sample.  Do not adjust the mirrors with no knobs.  If they need adjustment call the GLA, usually they do not need adjustment[bookmark: _Ref319836003]Figure 4 Diffuse Reflectance Accessory with beam path.



Small samples
Most typical lab samples are smaller in size than what the instrument was designed to measure.  For all three types of measurements (T, C, and R), it is best to under fill the sample. No light can go around the sample.
Spot size - There are two ways of reducing the beam spot size:
1) Slit width: The simplest way is narrow the slit width.  Click on the Setup:options tab.  Under slit height, switch to Reduced.  It takes about a minute for the slit to change.
2) Small spot kit: There are a series of lenses that can be put in the optical path to focus the beam into a smaller spot on the sample.  The large mirror (M3) must be change; this mirror is always kept in the T position. There are also three lenses  (S2) with different focal lengths and marked T, C, and R for the three positions of the integrating sphere. 
3) Aperture kit for transmission measurements
	There are apertures used for reflection measurements that are in the drawer for the Cary.  They can be used on the entrance slit with the white spectralon facing toward the integrating sphere.  You ideally would like the sample to completely fill the hole in the aperture and the sample light beam to be about the same size as the aperture.  If the sample is smaller than the hole in the aperture you need to mask the sample with black tape.
4) Aperture kit for reflection measurements
For normal incidence reflection measurements, the open circle in the rear of the integrating sphere is several inches in diameter.  There are a series of apertures, which have the white Spectralon material, that slide onto the slot on the back of the integrating sphere.  The spring-loaded mount that holds the sample against the integrating sphere needs to be taken off.  Slide on the appropriate aperture (you can use a little tape to hold it in place) then put the spring-loaded sample mount back on.
If the beam spot overfills the aperture a little, you can correct for this “stray light” by performing a Zero/baseline Correction.  Normally, the 0%T Baseline scan is run by blocking the beam before it enters the integrating sphere, which accounts for electronic noise.  To correct for overfilling, do not block the beam and if doing reflectance leave the exit port open (but the aperture in place) so that the 0%T Baseline will see light that hits the aperture and will account for the light reflecting from the edges of the aperture. 
Performing a Zero/Baseline Correction: Select this option to apply a 100%T baseline correction (100%TBaseline) and a zero-line correction (0%TBaseline) to the sample scan (S). This correction is performed with the raw transmission data and is thus:

With this option, the Cary will prompt you to perform a 100%TBaseline first, followed by a 0%TBaseline when you perform a baseline collection.


Basics of measurement acquisition
The wavelength range is 1800 nm to 250 nm.   Scans normally go from long to short wavelengths.  There are two detectors, a PMT and an InGaAs.  The wavelength at which the system changes from one to the other (accompanied by a grating change) can be adjusted.  Usually 750 to 800 nm is a good value for this change over.  You can see the change in the spectrum when you take a baseline (% Transmission or Reflection).  If you see a step in the spectrum, it may mean your baseline is bad or that your sample has a polarization dependency. 
Setup – The setup button located in the upper left-hand corner defines the scan parameters.  The following useful tabs can be found under Setup. 
Cary tab 
Here you can set the Wavelength Range, the units of the x-and y axes (nm, cm-1, etc. and A, %T, %R, etc.), as well as the range for the axes.  Under scan controls, the average time per data point and the data interval can be set.  Note that the Scan Rate will be automatically determined from these values.
Options tab 
Here you control the Beam Mode, Spectral Band Width (SBW), and Slit Height (see Appendix A of this guide for more info).  The Double beam mode needs to be used for the integrating sphere measurements and the SBW is typically set to 2nm. 
The Slit Height can be used to decrease the beam spot size normally it is set to full.
Typically, the UV-Vis button will be selected.  If you do not need to go to shorter wavelengths than 400 nm, you can select the Vis button, which will turn off the UV lamp.   
Baseline tab 
This tab enables you to choose the type of baseline(s) that you want to use in the Scan run. The different types of baseline corrections are particularly useful with some of the Varian accessories. You can collect a baseline immediately before scanning a sample or use a stored baseline.
The accuracy of your baseline determines the accuracy of your measurement.  You should perform a zero/baseline correction before running your samples after the instrument has warmed up for ~20 minutes using the same scan parameters that you will use for your sample. 
The Cary WinUV system collects a new baseline when you select any type of baseline correction in the Baseline tab of the Setup dialog box and then click Baseline button in the application window. Depending on the type of correction you have selected, the Cary will prompt you to perform either one or two baseline scans. The first is a 100%Tbaseline (for the DRA with the 100% reference material in the sample positions). The second, if required, is a 0%Tbaseline (with the sample beam blocked).
Once the baselines have been collected, they will be automatically applied to each collected sample data point as it is displayed (indicated by the red display). If there is not a corresponding data point in the current baseline, then the file will be interpolated to provide the correction. The correction applied to each point is dependent on the selected baseline type in the Baseline tab. 
A baseline cannot be applied to a sample where the wavelength range of the sample exceeds that of the baseline. If you change your wavelength range to one outside that of the baseline, the Cary will display an error message. Also, the red text in the ordinate (y) display, which indicates that the baseline correction mode is activated will disappear.
For reflection measurements using the aperture kit, if the beam spot overfills the aperture, you can correct for this “stray light” by performing a Zero/baseline Correction.  Normally, the 0%TBaseline scan is run by blocking the beam before it enters the integrating sphere, which accounts for electronic noise. In this case, do not block the beam, but instead remove the reflectance port cap to account for the light reflecting on the edges of the aperture (the remainder of the light should pass through the integrating sphere and not be detected).  
Performing a Zero/Baseline Correction: Select this option to apply a 100%T baseline correction (100%TBaseline) and a zero-line correction (0%TBaseline) to the sample scan (S). This correction is performed with the raw transmission data and is thus:

With this option, the Cary will prompt you to perform a 100%TBaseline first, followed by a 0%TBaseline when you perform a baseline collection.
This baseline option corrects for any inherent variations in the electronic zero line of the instrument. You should use this baseline option if your samples have areas of very low transmission (high absorbance) as any variations in the instrument's zero line will affect your measurements if they you do not correct for these. You should refer to ASTM method E903 for further details.
See Appendix B for more info on the acquisition, storing, and retrieval of baseline files
Independent Tab
This is normally not changed from default Auto in Measurement Mode.  In this mode the instrument will collect double spectra using a fixed SBW in the UV-Vis region and a fixed energy or detector gain in the NIR region.
You can explicitly set how the instrument controls the detector readings in each region. With either Auto or Fixed SBW set as the Measurement Mode, you must set a SBW value in the UV-Vis group.  The normal setting is 2.00 nm. You will find that the Energy level will change automatically to maintain the required signal level. If you want the instrument to san in another mode i.e. fixe SBE in the NIR or fixed energy (gain) in the UV-Vis region you can set that here.
[bookmark: Storage]Storage tab 
The Auto Store tab allows you to specify if you want to be prompted to store the collected data. You can store the data in a Batch or Data file at the start or end of a collect. There are 3 different options for automatically storing your data
Storage Off:  Select this if you do not wish to be automatically prompted to save collected data. To manually store your unsaved data after the run is complete, choose Save Data As from the File Menu. You can save your data as a Batch or Data file. In the Scan application, data is automatically stored as a Data file. See the Note below.
Storage On (Prompt At Start): Select this to display the Windows Save As dialog box at the start of the collect where you can enter the Batch file name for your data.
Storage On (Prompt At End): Select this to display the Windows Save As dialog box at the end of a collect where you can enter the Batch file name for your data.
	
	[bookmark: Note]Note
In the Scan application, Prompt at Start and Prompt at End save information as a *.DSW file unless there are multi or cycle scans being performed. In these cases, information is saved in a Batch file.



Commands Menu 
Commands in this application can be accessed both from the menu items at the top of the main window and from the application buttons on the right hand side of the screen. Alternatively, you can use function key shortcuts for some of the commands. These appear next to the item in the Commands menu. 
Start: Select this to start a Scan run using the currently set up parameters. Function key is F9. 
Stop: Select this to stop a Scan run. If you have selected Storage On in the Auto Store tab of the Setup dialog box, all data collected is automatically stored in the file specified in the Batch name field of the Windows Save As dialog box before or after the run commenced. Function key is F12. 
Connect: The Connect command becomes available when more than one software application is running at any one time. The application that is in use will be online and will have control of the Cary. All other applications will be offline and display the Connect command. If you wish to swap to a different application (and still keep other applications running) you will need to select Connect in the application you wish to connect to the Cary. 
Zero: Select this to zero the current ordinate value using the Start wavelength (or equivalent) value set in the Cary tab of the Setup dialog box. The Cary will change to this wavelength if currently idling at a different value. Function key is F5. Do not use this if you sample is not zero at this wavelength.
Goto: Select this to display the go to Wavelength dialog box and change the instrument to a new wavelength. Function key is F4. This option is only available if the instrument is not currently collecting data.
Align:  This moves the Cary spectrophotometer to 0 nm (white light). You can then use this light for aligning accessories. Do not use unless you have blocked the sample and reference slots to the integrating sphere.
Lamps Off: Switches off all lamp sources.
Lamps On:  Switch on selected lamps.
Graph menu
The Graph menu allows you to view data in various graphical formats or in multiple graphs in the Graphics area. You can double-click on the Graphics area to toggle the display through graph and report to graph only.
The graph functions can also be accessed by:
· clicking one of the Toolbar buttons. 
· right-clicking in a graph box or the Graphics area. 
Not all functions are available on every menu.
	
	Note
The red trace in any graph box is the one for which all information appears and the one used for cursor tracking. It is called the focused trace.
If you hold the cursor over a trace, bubble text identifying the trace is shown.


Under the Graph menu, you can change both the Trace and Graph Preferences
Trace Preferences: Select to display the Trace Preferences window to choose the trace(s) to display in the selected graph.
Graph Preferences: Select to display the Graph Preferences dialog box and change the appearance of your graph. 
See Appendix C for more option under the Graph menu as well as the Trace Preferences and Graph Preferences menus
Storing Data
Under the File menu you can save your Method (the Setup configuration used to perform the scan), your Data, or the combination of the Method and Data as a Batch file.  
File, Save Method As 
Select this option to display the Save As dialog box and store the current method. You can use the Save As dialog box to store the method, data, report, or graphics template separately or together as a Batch file. The data can also be saved as a Cary GRAMS file, a comma delimited ASCII Spreadsheet file or in formats suitable for other Cary software systems (depends on which application you are running). 
File, Save Data As
Select this option to display the Save As dialog box and store the collected data. You can use the Save As dialog box to store the method, data or report separately or together as a Batch file. The data can also be saved as a Cary GRAMS file, a comma delimited ASCII Spreadsheet file or in formats suitable for other Cary software systems (depends on which application you are running).  After a batch file has been saved, you can use this option to manually save the file as a method file, a batch file, a comma delimited ASCII spreadsheet file or a Rich Text Format file.
How to Export Collected Data
If you want to export data from a Cary WinUV application into a third-party application, then save your data as an ASCII *.CSV file. To do this:
1. Click File menu item. 
2. Click Save Data As. The Save As dialog box will appear. 
3. Click the down arrow next to the Files of type list box. 
4. Select Spreadsheet ASCII (*.CSV). 
5. Type your file name into the File name field. 
6. Click Save to export your data. 
How to Combine Data Files into a Batch File:
If you have a number of data files that you need to combine into a batch file, then you need to:
1. Select Open Data from File menu. 
2. A list of previously stored batch files will appear. Click the down arrow at the right of the “Files of Type” list box and select 'Data' to list all the data files. 
3. Check the Overlay Data check box. 
4. Highlight the data files that you require and click Open. The highlighted data files will load into the application and appear in the same graph box. 
5. Select Save Data As from the File menu. 
6. A list of previously stored data files will appear. Click the down arrow at the right of the “Files of Type” list box and select 'Batch' to list all the batch files. 
7. Make sure that the Save only focused trace check box is not checked. 
8. In the File name field, type in the file name for your new batch file. 
9. Click Save to create the new batch file. The current method will be stored with the batch files. All the data files are now combined into the one batch file.

Appendix A
How the Cary 5000/6000i Controls SBW and Energy
In a spectrometer the intensity observed by the detector changes with wavelength. Double beam spectrometers normally control the reading from the detectors to make sure that they stay within their optimum region.  This can be done in two ways.  You can open and close the slits to increase or decrease the amount of light that reaches the detector or you can change the gain on the detector to make it have higher gain when the light energy is low and visa versa.  Normally one likes to have the Spectral Band Width (SBW) stay constant (i.e. constant slit width).  This is easy in the UV-Vis region where the detector is a photomultiplier tube (PMT) that allows a very large change in gain.  However, in the NIR region this historically was less possible since you are using a PbS detector.  Thus, what was done was to let the SBW vary to maintain the detector output. In our Cary we have an InGaAS detector and while you can not change the gain on the detector it is very low noise and you can use an amplifier with settable gain after the detector to boost the signal.
In Double or Double Reverse Beam Mode in the UV-Vis region the slit width (SBW) is normally kept constant and the Energy level (gain) is changed. In the NIR region (InGaAs detector) the reverse is normally true i.e. the Energy level is constant and the  SBW (slits) changes. Due to the inherent differences between the two types of detector, the different methods of control normally ensure the widest dynamic range and the best signal to noise. 
The instrument uses two detectors (PMT and InGaAs diode), two light sources (W bulb and D2 lamp), and two gratings in the monochromator.  You can set the wavelength at which the detectors and gratings change.  Both of these are typically set at 800 nm, if you have an important spectroscopic feature at 800 nm, you can move the change over ± 50 nm.  The lamp changeover is normally set to 350 nm but again can be moved ± 50 nm
Note that the instrument uses gratings to disperse the light and needs order sorting filters to remove 2nd (and 3rd ) order light from the output beam (i.e. at 800 nm you would also get 400 and 200 nm light).  The filters change are at 350, 570, 800, and 1200 nm.  You cannot move their changeover wavelengths.
If you are collecting data in double beam mode in the UV-Vis regions, you can set how the instrument controls the detector readings.  In SETUP under the independent tab if you choose how the double beam spectra are collected. With either Auto or Fixed SBW set as the Measurement Mode, you set SBW (slit bandwidth) value in the UV-Vis group.  The normal setting is 2.00 nm.  You will find that the Energy level will change automatically to maintain the required signal level. 
If you are collecting data in double beam mode in the NIR region ( the detector change wavelength setting, generally 800nm), with either Auto or Fixed Energy set as the Measurement Mode, the Energy level is fixed in the NIR group. An Energy setting of 1.0 will provide the best signal-to-noise ratio but with a larger SBW.  In most cases, the recommended setting is 3.0; this provides a smaller SBW over the entire region and a better match of the SBW in the NIR region and the Vis region. You will find that the SBW will change automatically to maintain the required signal level. 
[image: A picture containing chart

Description automatically generated]If you are collecting data in double beam mode across the UV-Vis and NIR regions with Fixed SBW set as the Measurement Mode then you will need to enter values in the SBW fields in both the UV-Vis and the NIR group boxes. The values can be the same if you want to use the same SBW across the whole scan or you can set different values for each region, normally the SBW in the NIR is >> then the SBW in the UV-Vis.
Note that the SBW is in nm and for a fixed setting of the SBW the resolution in energy terms will be much better in the NIR then in the UV or Vis regions (see figure).  A spectra band width of 2 nm at 400 nm corresponds to 124 cm-1 while at 1200 nm 124 cm-1 give a SBW of about 18 nm.  This is one reason that most absorption peaks in the NIR are much broader in wavelength then peaks in the UV-Vis regions. It also suggests that you can collect at a wider SBW in the NIR than the visible regions.

Appendix B: 
Acquiring, storing, and retrieving baseline files
The Cary WinUV system collects a new baseline when you select any type of baseline correction in the Baseline tab of the Setup dialog box and then click the Baseline button in the application window. Depending on the type of correction you have selected, the Cary will prompt you to perform either one or two baseline scans. The first is always a 100%Tbaseline (with nothing in the beam, or in the case of a Diffuse or Specular Reflectance measurements, with the 100% reference material in position). The second, if required, is a 0%Tbaseline (with the sample beam totally blocked so that the instrument can measure the electronic zero values).
Once the baselines have been collected, they will be automatically applied to each collected sample data according to the appropriate baseline correction equation. If there is not a corresponding data point in the current baseline, then the file will be interpolated to provide the correction. The correction applied to each point is dependent on the selected baseline type in the Baseline tab. 
A baseline cannot be applied to a sample where the abscissa range of the sample exceeds that of the baseline. If you change your abscissa range to one outside that of the baseline, the Cary will display an error message. Also, the red text in the ordinate display which indicates that baseline correction mode is activated will disappear.
Not that all values within the Baseline abscissa range are corrected, even the value displayed while the Cary is idling at a particular wavelength.
Note
 You should be careful applying corrections to samples where the following parameters are different in the baseline file and the samples. Energy, SBW, Beam Mode, Source Changeover, Detector Changeover Grating Changeover, Selected Lamp for the collection, Signal-to-Noise Mode, Slit height and the Independent Control.
Baselines are saved as a part of a batch file. However, if you want, you can also store the baselines by themselves in a baseline file without the collected data. To do this you simply select the Baseline (*.CSW) as the Save As Type in the Save As window accessed from the File | Save Data As menu items. When you want to use the baselines for another Scan run, you simply open the file using either the File | Open Data command or click the Baseline button in the Baseline tab of the Setup dialog box.
	
	Note
If you decide that you do not want to use that stored file, but want to collect a new baseline instead, then the Cary will use the new, collected baseline in all corrections. However, the Baseline tab will still display the name of the baseline in the baseline file. You need to save the collected data as a batch file if you want the new baseline included in that file. 

	
	Note
All corrections are performed with the raw transmission data that comes directly from the instrument. These transmission values are then converted into the selected Y mode for display.


A baseline cannot be applied to a sample where the abscissa range of the sample exceeds that of the baseline. If you wish to use that baseline then you will need to reduce the range of the scan by changing the Start and Stop fields on the Cary tab of the Setup dialog box.
Types of baselines that can be performed.
Choose the type of baseline correction under the Baseline tab in the Setup menu
Baseline Correction
Select this option to apply a baseline correction (Baseline) to the sample scan (S) that is collected from the instrument as transmission values.
This correction is thus:

Zero/Baseline Correction
Select this option to apply a 100%T baseline correction (100%TBaseline) and a zero-line correction (0%TBaseline) to the sample scan (S). This correction is performed with the raw transmission data and is thus:

With this option, the Cary will prompt you to perform a 100%TBaseline first, followed by a 0%TBaseline when you perform a baseline collection.
This baseline option corrects for any inherent variations in the electronic zero line of the instrument. You should use this baseline option if your samples have areas of very low transmission (high absorbance) as any variations in the instrument's zero line will affect your measurements if they you do not correct for these. You should refer to ASTM method E903 for further details.
Zero SRA correction
Select this option to apply a 100 %T baseline correction (100%TBaseline) and a zero-line correction (0%TBaseline) to a sample (S) measured with an Absolute VW Specular Reflectance Accessory (SRA). 
	
	Note
The VN SRA and the single bounce relative SRA accessories should not use this correction. Select a Baseline/Zero correction instead.


This correction is performed with the raw transmission data and, due to the double bounce on the sample, is thus:

With this option, the Cary will prompt you to perform a 100%TBaseline first, followed by a 0%TBaseline when you perform a baseline collection. You should refer to ASTM method E903 for further details.
Zero *Std. Ref. Correction
Select this option to apply a 100 %T baseline (100%TBaseline) correction and a zero-line correction (0%TBaseline) to a sample (S) measured with a reflectance accessory which is not absolute (e.g., a Diffuse Reflectance Accessory or the Variable Angle Specular Reflectance accessory). The Cary then multiplies the result by the appropriate value in the 'Baseline Stdref' file which are the transmission values associated with the Standard Reference material you used to establish the baseline. Refer to the help for the Diffuse Reflectance accessories for further details about Standard Reference materials.
This correction is performed with the raw transmission data and is thus:

With this option, the Cary will prompt you to perform a 100%TBaseline first, followed by a 0%TBaseline when you perform a baseline collection.
	
	Note
If you select this option the Baseline button in the main window will not be enabled until you have retrieved a Std Ref file. Click this button to browse for and select a Std Ref file. This file must be in the  correct format.


Known Mirror
Select this option when you are using a VW Specular Reflectance Accessory (SRA) with a small sample or a sample of low reflectance. Refer to your SRA manual for more information.
Known Mirror Correction
The correction equation is as follows:

where

	
		Tip 
If baseline correction is activated, the type of correction that the Cary will apply will appear in the in red.
	

	However, sometimes you may notice that the text has turned to gray and is in italics. This indicates that the Cary is currently idling outside the abscissa range of the baseline file, but that the current method Start/Stop parameters do not exceed the abscissa range of the baseline. 
	





Retrieve Baseline File
This button displays the Windows Open dialog box where you can select a stored baseline file. The trace(s) in this file will be used for the selected baseline correction. The name of the selected file appears next to the Baseline button.
	
	Tip
If you want to use the baseline again with other samples, save the method using File | Save Method As. Then, when you re-open the method, the baseline will also open and be ready to use. It is preferable to save the baseline with the method, rather than a baseline file, as that way you can be sure that all your collection parameters are exactly the same for the new Scan runs. However, Good Laboratory Practice recommends that you collect a new baseline for each laboratory session.


View Baseline File
This displays the traces in the selected baseline file in the Graphics area.
[bookmark: Stdref]Retrieve Std Ref File
This button displays the Windows Open dialog box where you can select a stored reference file. The trace in this file will be used in the Zero x Std Ref Correction. The name of the selected file appears next to the Std Ref button. 
	
	Tip
The Std Ref file must be in the valid format. You can obtain these files from the manufacturer of the standard that you are using. 


· How to create and use a standard reference file 
	
	Q. Why is my Retrieve Std Ref button unavailable?
A. You need to select the Correction type as 'Zero *Std. Ref. Correction'.



View Std Ref File
This displays the traces in the selected standard reference file in the Graphics area.
[bookmark: ShowStatusDisplay]Show Status Display 
Select this check box to display the Show Statusmaster.chm::/master/apphelp/co_status_display.htm window. This window allows you to view the status of various parameters during the data collection.

Appendix C
Graph menu, Trace Preferences and Graph Preferences options
1) Graph menu options
Print XY point: Select this to print the cursor's current X and Y coordinates in the report area. This option is only available when right-clicking in a graph box.
Trace Preferences: Select this to display the Trace Preferences window to choose the trace(s) to display in the selected graph (Trace Preferences are listed below).
Graph Preferences: Select this to display the Graph Preferences dialog box and change the appearance of your graph. Any changes you make to the appearance of the graph will apply to all graphs until the settings are changed again. (Graph preferences options are listed below).
Cursor Mode: Select this to display the Cursor Modes dialog box to enable you to use different cursors on the screen. You can select to use a free cursor that can move anywhere in the graph or exactly trace the focused scan (red scan).
Axes Scales: Select this to display the Axes Scales dialog box and change the range of the axes.
Autoscale[XY]: Select Autoscale[XY] to automatically scale collected data by scaling the ordinate (Y) height and abscissa (X) width to full screen.
Autoscale[X]: Select Autoscale[X] to automatically scale collected data by scaling the abscissa (X) width to full screen.
Autoscale[Y]: Select Autoscale[Y] to automatically scale collected data by scaling the ordinate (Y) height to full screen.
Zoom Out: Select Zoom Out to Zoom back to the original X and Y axis scaling set in the Cary Setup tab. This will undo all zooming.
Add Label : Select Add Label to display the Add Label dialog box to enable you to place a text label on your graph. 
Add Picture : Select Add Picture to display the Add Picture dialog box to insert a picture, bitmap or chemical structure into your graph. 
Edit Annotation: Select Edit Annotation to alter the content or look of an annotation (such as a label or a picture) in the Graphics area.
Delete Annotation: Select Delete Annotation to remove an annotation (such as a label or a picture) from the Graphics area.
	
	


Single/Multi Graph : Select Single/Multi Graph to toggle between displaying one or all graphs. 
Auto Arrange Graphs: Select Auto Arrange Graphs to view and arrange all graphs simultaneously.
Copy Graph: Select this to copy the Graphics area onto the Windows Clipboard.
Paste to Graph: Select this to paste the contents of the Windows Clipboard into the Graphics area. Text is pasted as a label; graphics are pasted as pictures.
Add Graph: Click Add Graph to add a new graph box to the Graphics area.
Remove Graph: Click Remove Graph to delete the selected graph box from the Graphics area.
Clear All Traces: Select Clear All Traces to delete all traces from the graph/s.
User Data Form: Select this to display the User Data Form.
Maths: Select this to enable the Maths window. This option is only available when right-clicking in a graph box.
History List: This displays a list of the current graphs.
2) Trace Preferences 
A single graph box can display many traces. This window enables you to select the trace(s) to display (make visible) in the selected graph box or color space. Trace Preferences is accessible from the Graph menu, by right-clicking on a trace or by clicking on the toolbar.
	The Trace Preferences menu is also available by right-clicking anywhere in the trace listing.


[bookmark: Visible]Visible: This field allows you to determine which traces will appear on the selected graph. Click in this column to place a tick next to the trace you want to appear on the graph. Click again to remove the tick next to the trace.
If you are in single graph view, all selected traces will appear on the one graph. If you are in Multi Graph view, the traces will appear on the graph that is currently selected.
Color: This shows the color in which the trace will be displayed in the graph box. The red trace in any graph box is the one on which all information appears and the one used for the cursor tracking. It is called the focused trace and it is always red.
Clicking on a trace in the Color column will cause that trace to become the focused trace in the selected graph box. You can also change the color of any trace (when it is not the focused trace), from the Trace Preferences menu.
	When you change the trace line width in the Graph Preference dialog box, it also will change the width of the color trace line in this window.


Name of Trace: This field contains a description of the traces currently available for display in the selected graph box. If a trace is not already ticked as visible, you can click to activate this property. Right-clicking in this column displays the Trace Preferences menu. This menu allows you to change some of the properties of the traces, as well as hiding, displaying or deleting certain traces. 
	You can resize the “Name of Trace” and “File” name fields by selecting and dragging the splitter bar between the fields.


File Name: This field displays the file name and path of the trace. If the name is too long to appear in the field, you can use the arrow keys to scroll to the end of the file name or you can maximize the Trace Preferences window. If the file path for a trace shows 'not saved', the trace is unsaved data and is only stored in memory.
Trace Audit Log: This field displays information about the trace that is highlighted. It includes instrument parameters and data form information relating to the trace that has been selected. When more than one trace is highlighted, this displays information on the trace that was last selected.
Select Traces: The drop-down arrow reveals any columns you have created in the User Data Form. You can select traces based on any of the columns you have created.
3) Graph Preferences 
This dialog box allows you to change the appearance of your graph. Graph Preferences is accessible from the Graph menu, by right-clicking on a trace or by clicking Graph preferences icon on the toolbar.  All graphs will appear labeled with the X axis label being horizontal and the Y axis vertical. You cannot change the orientation of these labels. However, you can alter the font and size of the axes and their labels. Any changes you make to the appearance of the graph will apply to all graphs until the settings are changed again.
[bookmark: 5a57ea5][bookmark: standard]Standard Tab: This tab allows you alter the way your graph appears on screen. You can view the changes you make before accepting them in the Preview box.
Preview Box: A preview of each of the axes variables is shown to the right of this dialog box. To change the view, alter the settings in the variables on the left.
Axes Color: From the drop-down list, select the color that you want to assign to the axes of the graph(s).
Axes Width: From the drop-down list, select the width of the axes. The width is given in pixels and ranges between one and five pixels.
Grid Style: This drop-down list allows you to specify whether or not you want a grid on your graph. You can also define the type of grid.
Plot Area Color: This drop-down list enables you to specify what (if any) color you would like as the background of the graph.
Trace Width: From this drop-down list you can select the width of the trace. The width is given in pixels and ranges between one and five pixels.
Font: This button displays the Windows Font dialog box that allows you to define the font style for the axes of the graph(s). The style and size of the font will be applied to all graphs until the font is changed again.
[bookmark: 5a57ed0]Trace Style: This field allows you to define the way that your trace will appear on screen.
	Points
	Each individual data point collected by the Cary is shown on the graph.

	Points and 
solid lines
	Each individual data point collected by the Cary is shown on the graph. An interpolated line is drawn connecting the points.

	Solid lines
	The Cary system interpolates the data between the actual, collected data points and shows the data as a continuous line.

	Style cycles automatically
	The Cary system will give each trace one of the above styles making it easier to differentiate between traces, especially on black-and-white printers. Style cycling will only occur when the Trace Width has been selected at 1 pixel.


[bookmark: advanced]
Advanced Tab: This tab allows you to further refine the way your graph looks. For each option you can make individual changes to the X, Y or both axes.
Auto tick marks: Use the slider bars to alter the number of tick marks (graduations) that you want to appear on your graph.  If you have selected the Major Ticks check box, this option is unavailable.
Major ticks: Select this to determine how many tick marks (graduations) you want to appear on each axis of your graph.
Decimals: Select this to determine how many decimal places you want to assign to each tick mark (graduation) on your graph.
Show Legend: Select this to display a legend on the right side of each graph box.
A single click on a sample name or example line within the legend will make it the focused or red scan. Information about the trace will be displayed below the X axis. 
	Double-clicking the legend will automatically display the Trace Preferences window, allowing you to view more detailed information about your trace (e.g., audit log, file name, etc.).
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